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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer
“Documentation” means information published by Avaya in varying
mediums which may include product information, operating
instructions and performance specifications that Avaya generally
makes available to users of its products. Documentation does not
include marketing materials. Avaya shall not be responsible for any
modifications, additions, or deletions to the original published version
of documentation unless such modifications, additions, or deletions
were performed by Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty
Avaya provides a limited warranty on its hardware and Software
(“Product(s)”). Refer to your sales agreement to establish the terms
of the limited warranty. In addition, Avaya’s standard warranty
language, as well as information regarding support for this Product
while under warranty is available to Avaya customers and other
parties through the Avaya Support website: http://support.avaya.com.
Please note that if you acquired the Product(s) from an authorized
Avaya Channel Partner outside of the United States and Canada, the
warranty is provided to you by said Avaya Channel Partner and not
by Avaya. “Software” means computer programs in object code,
provided by Avaya or an Avaya Channel Partner, whether as stand-
alone products or pre-installed on hardware products, and any
upgrades, updates, bug fixes, or modified versions.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO ARE
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR
INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC.,
ANY AVAYA AFFILIATE, OR AN AUTHORIZED AVAYA CHANNEL
PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AUTHORIZED AVAYA
CHANNEL PARTNER. UNLESS OTHERWISE AGREED TO BY
AVAYA IN WRITING, AVAYA DOES NOT EXTEND THIS LICENSE
IF THE SOFTWARE WAS OBTAINED FROM ANYONE OTHER
THAN AVAYA, AN AVAYA AFFILIATE OR AN AVAYA
AUTHORIZED AVAYA CHANNEL PARTNER; AVAYA RESERVES
THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU AND
ANYONE ELSE USING OR SELLING THE SOFTWARE WITHOUT
A LICENSE. BY INSTALLING, DOWNLOADING OR USING THE
SOFTWARE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
INSTALLING, DOWNLOADING OR USING THE SOFTWARE
(HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU”
AND “END USER”), AGREE TO THESE TERMS AND CONDITIONS
AND CREATE A BINDING CONTRACT BETWEEN YOU AND
AVAYA INC. OR THE APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants you a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the

applicable license will be a Designated System License. The
applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to you. “Designated Processor” means a single
stand-alone computing device. “Server” means a Designated
Processor that hosts a software application to be accessed by
multiple users.

Licence types
CPU License (CP). End User may install and use each copy of the
Software on a number of Servers up to the number indicated in the
order provided that the performance capacity of the Server(s) does
not exceed the performance capacity specified for the Software. End
User may not re-install or operate the Software on Server(s) with a
larger performance capacity without Avaya’s prior consent and
payment of an upgrade fee.

Named User License (NU). You may: (i) install and use the Software
on a single Designated Processor or Server per authorized Named
User (defined below); or (ii) install and use the Software on a Server
so long as only authorized Named Users access and use the
Software. “Named User”, means a user or device that has been
expressly authorized by Avaya to access and use the Software. At
Avaya’s sole discretion, a “Named User” may be, without limitation,
designated by name, corporate function (e.g., webmaster or
helpdesk), an e-mail or voice mail account in the name of a person or
corporate function, or a directory entry in the administrative database
utilized by the Software that permits one user to interface with the
Software.

Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software currently
available for license from Avaya is the software contained within the
list of Heritage Nortel Products located at http://support.avaya.com/
LicenseInfo under the link “Heritage Nortel Products”. For Heritage
Nortel Software, Avaya grants Customer a license to use Heritage
Nortel Software provided hereunder solely to the extent of the
authorized activation or authorized usage level, solely for the purpose
specified in the Documentation, and solely as embedded in, for
execution on, or (in the event the applicable Documentation permits
installation on non-Avaya equipment) for communication with Avaya
equipment. Charges for Heritage Nortel Software may be based on
extent of activation or use authorized as specified in an order or
invoice.

Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, or hardware
provided by Avaya. All content on this site, the documentation and
the Product provided by Avaya including the selection, arrangement
and design of the content is owned either by Avaya or its licensors
and is protected by copyright and other intellectual property laws
including the sui generis rights relating to the protection of databases.
You may not modify, copy, reproduce, republish, upload, post,
transmit or distribute in any way any content, in whole or in part,
including any code and software unless expressly authorized by
Avaya. Unauthorized reproduction, transmission, dissemination,
storage, and or use without the express written consent of Avaya can
be a criminal, as well as a civil offense under the applicable law.

Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software that may contain software
(including open source software) distributed under third party
agreements (“Third Party Components”), which contain terms
regarding the rights to use certain portions of the Software (“Third
Party Terms”). Information regarding distributed Linux OS source
code (for those Products that have distributed Linux OS source code)
and identifying the copyright holders of the Third Party Components
and the Third Party Terms that apply is available in the
Documentation or on Avaya’s website at: http://support.avaya.com/
Copyright. You agree to the Third Party Terms for any such Third
Party Components.

This product is licensed under the AVC patent portfolio license for the
personal use of a consumer or other uses in which it does not receive

http://support.avaya.com/
http://www.avaya.com/support/LicenseInfo
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remuneration to (i) encode video in compliance with the AVC
standard ("AVC video") and/or (ii) decode AVC video that was
encoded by a consumer engaged in a personal activity and/or was
obtained from a video provider licensed to provide a VC video. No
license is granted or shall be implied for any other use. Additional
information may be obtained from MPEG LA, L.L.C. See http://
www.mpegla.com/.

Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention
If you suspect that you are being victimized by Toll Fraud and you
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: http://support.avaya.com. Suspected
security vulnerabilities with Avaya products should be reported to
Avaya by sending mail to: securityalerts@avaya.com.

Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation and Product(s) provided by Avaya are the
registered or unregistered Marks of Avaya, its affiliates, or other third
parties. Users are not permitted to use such Marks without prior
written consent from Avaya or such third party which may own the
Mark. Nothing contained in this site, the Documentation and
Product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.

Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: http://support.avaya.com.

Contact Avaya Support
See the Avaya Support website: http://support.avaya.com for product
notices and articles, or to report a problem with your Avaya product.
For a list of support telephone numbers and contact addresses, go to
the Avaya Support website: http://support.avaya.com, scroll to the
bottom of the page, and select Contact Avaya Support.

http://www.mpegla.com/
http://www.mpegla.com/
http://support.avaya.com
http://support.avaya.com
http://support.avaya.com
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Chapter 1: New in this release

The following sections detail what's new in Administering Avaya Collaboration Services
(NN10850-031) for Release 6.4.

Application rebranding
The Avaya Client Applications product name is no longer attached to the Avaya Collaboration
Services application. All Avaya Client Applications references in this document have been removed.

Instant Messaging and Presence enhancements
The Avaya Collaboration Services IM and Presence functionality has been enhanced to work on all
UC desktop clients that interwork with Avaya Collaboration Services.

Support for Windows 8.1 and Firefox
Avaya Collaboration Services now supports:

• Windows 8.1 operating systems
• Firefox browsers
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Chapter 2: Introduction

This document provides the information needed to configure and build the Collaboration Services
installation packages.

Documentation terminology
The following terminology is used throughout the Collaboration Services documentation.

• This document: Administering Avaya Collaboration Services (NN10850–031)

• User guides and help sets:

- Using Avaya Collaboration Services (02-604208)

- Avaya Configurator User Guide (02-604198)

Product names
The following names are also used to refer to the Avaya Collaboration Services application.

• Avaya Collaboration Services
• Collaboration Services

Applications
The following names are used to refer to the Collaboration Services Office and Browser applications
when one of these applications is called out separately.

• Collaboration Services Office and Browser applications
• Office and Browser applications
• Office and Browser Add-ins

Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot Avaya
products.
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About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com, select the

product name, and check the videos checkbox to see a list of available videos.

• To find the Avaya Mentor videos on YouTube, go to http://www.youtube.com/AvayaMentor and
perform one of the following actions:

• Enter a key word or key words in the Search Channel to search for a specific product or
topic.

• Scroll down Playlists, and click the name of a topic to see the available list of videos posted
on the site.

Note:

Videos are not available for all products.

Support
Visit the Avaya Support website at http://support.avaya.com for the most up-to-date documentation,
product notices, and knowledge articles. You can also search for release notes, downloads, and
resolutions to issues. Use the online service request system to create a service request. Chat with
live agents to get answers to questions, or request an agent to connect you to a support team if an
issue requires additional expertise.

Introduction
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Chapter 3: Overview

The following sections provide an overview of Avaya Collaboration Services and the conceptual
information to help you build installation packages using the Configurator.

The Avaya Collaboration Services applications can interwork with Lync Integration and Avaya one-
X® Communicator for Windows. The Configurator builds a separate installation package for Lync
Integration. There is no option to select Avaya one-X® Communicator in the Configurator and the
Configurator does not build an installation package for Avaya one-X® Communicator. However,
when deployed, Avaya Collaboration Services will automatically detect if Avaya one-X®

Communicator is running on the Windows desktop.

Configurator
The Avaya Configurator is an administrative tool that you use to configure and build the
Collaboration Services installation package prior to distribution to end users.

Administrators must have Microsoft .NET Framework 3.5 to run the Configurator installation
package. For a complete list of system requirements, see Configurator requirements on page 11.

Collaboration Services
When you run a Configurator build, you always build the installation package for the Collaboration
Services Office and Browser applications.

Use the Custom Rule Creator to create the Browser and Office Custom Rules file. This file contains
the custom number and pattern matching rules to be included in the corresponding application
installation package. With the Custom Rule Creator, you can define a custom rule for a particular
web browser subnet and the URL matching scheme. You can define Smart Tag custom rules for
Microsoft desktop applications and the conference dialer pattern matching rule for the click-to-join
conference feature.

Lync Integration
Enable Lync Integration and configure the installation package for Lync Integration.

You can include this installation package with the build of the Collaboration Services installation
package.

For more information on the Avaya Lync Integration solution and requirements, including using the
Configurator to build the installation package, see the following document:

• Avaya Microsoft Lync Integration Fundamentals for Avaya Aura® (NN10850–014)
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Installation packages
The Configurator produces a configured installation package containing the Collaboration Services
applications, and a separate installation package for Lync Integration. You can distribute these
installation packages to end users.

Overview
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Chapter 4: System requirements

Review the system requirements before building the installation packages and distributing them to
end users.

Configurator requirements
The Configurator is an administrative tool used to configure and build the installation packages for
the Collaboration applications prior to distribution to end users.

Table 1: Configurator requirements for administrators

Software prerequisites Supported OS Privileges
Administrators must have the
following software installed on
their systems before installing the
Configurator:

• Microsoft.NET Framework 3.5 or
higher

Administrators must be running one of the
following operating systems (OS):

• Microsoft Windows 7

• Microsoft Windows 8

Make sure the OS is fully updated with all
Microsoft patches.

Administrator

Browser Add-in requirements
Users should close all existing browser sessions before installing Avaya Collaboration Services.
Following the installation of Collaboration Services, when users launch their web browser for the first
time, they must enable Collaboration Services at the prompt, and then restart the browser if
necessary.

Important:

Microsoft Internet Explorer running on Windows 7 separates Collaboration Services Browser
application data for sites in different security zones. For example, if a user makes a changes to
the highlighting style, or enables and disables Collaboration Services, these changes do not
propagate to windows or tabs that are showing pages in different security zones.
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Table 2: Browser Add-in requirements for end users

Software prerequisites Supported OS Supported browsers Installation
privileges

Users must have the following
software installed on their
systems to use the
Collaboration Services
Browser Add-in.

• Microsoft.NET Framework
3.5 and 4.0

• Avaya Microsoft Lync
Integration and
Microsoft.NET Framework
4.0 if integrating with
Microsoft Lync Integration

Users must be running one
of the following operating
systems (OS):

• Microsoft Windows 7

• Microsoft Windows 8

Make sure the OS is fully
updated with all Microsoft
patches.

Users must be using one
of the following browsers:

• Internet Explorer 8, 9,
10, and 11

• Firefox

• Google Chrome

Administrator

Office Add-in requirements
Users should close all existing Microsoft Outlook sessions before installing Avaya Collaboration
Services.

Table 3: Office Add-in requirements for end users

Software prerequisites Supported OS Supported Office
versions

Installation privileges

Users must have the
following software
installed on their systems
before running the
Collaboration Services
Office Add-in.

• Microsoft.NET
Framework 3.5 and 4.0

• Avaya Microsoft Lync
Integration and
Microsoft.NET
Framework 4.0 if
integrating with
Microsoft Lync
Integration

Users must be running one
of the following operating
systems (OS):

• Microsoft Windows 7

• Microsoft Windows 8

Make sure the OS is fully
updated with all Microsoft
patches.

Users must be
using one of the
following Microsoft
Office versions:

• Office 2007

• Office 2010

• Office 2013

Administrator

System requirements
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Virtual Desktop interoperability requirements
The following table summarizes the main VDI product and server requirements.

Table 4: VDI requirements

Virtual Desktop versions • Citrix Xen Desktop: Version 5.6

• Citrix Xen Applications: Version 6.5

• VMWare Horizon View: Version 5.3
Virtual Desktop servers Windows 2008 R2 Enterprise for Citrix Xen Desktop, Citrix Xen

Applications, and VMWare Horizon View.
VDI Communicator Version 1.0

Collaboration Services Outlook add-in Interoperability
requirements

Remove the following Outlook Add-ins to improve the overall performance of Outlook:
• Avaya one-X® Communicator Outlook Integrator.
• Avaya Aura® Conferencing Conference Manager.

When deploying Collaboration Services with Microsoft Lync Integration and Avaya Communicator
for Windows, remove the following Outlook Add-ins:

• Microsoft Office Communicator 2007 Outlook Add-in.
• Lync Meeting Add-in.

You should also remove any other Outlook add-ins that you are not using.

Virtual Desktop interoperability requirements
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Chapter 5: Building the installation
packages

Build the installation package for Avaya Collaboration Services.

If you are deploying Collaboration Services with Lync Integration, see the following document for
more information:

• Avaya Microsoft Lync Integration Fundamentals for Avaya Aura® (NN10850–014)

If Collaboration Services will be interworking with an Avaya one-X® Communicator for Windows
client, see the following document for more information:

• Administering Avaya one-X® Communicator

Prerequisites for building the installation packages
• Be familiar with the System Requirements on page 11.

Related Links
Installing the Configurator on page 14
Configuring the installation packages for Collaboration Services with Lync Integration on page 15
Building the installation packages on page 16
Distributing the installation packages on page 17

Installing the Configurator
Install the Avaya Collaboration Services Configurator.

Before you begin
• Be running one of the following operating systems:

- Microsoft Windows 7
- Microsoft Windows 8

• Have Microsoft .NET Framework 3.5 SP1.
• Have the Collaboration.configurator.msi file on your desktop.
• Uninstall any previously installed versions of the Configurator.
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About this task
The Configurator is an administrative tool used to configure and build the installation packages for
the Collaboration applications prior to distribution of the applications to end users.

Procedure
1. Double-click the Configurator.msi file to launch the Windows installer for the Avaya

Collaboration Services Configurator.

2. When the Avaya Collaboration Services Configurator installer opens, click Next.

3. When the Avaya Collaboration Services Configurator setup wizard opens, click Next.

4. In the License Agreement window, click I Agree to accept the license agreement.

5. In the Select Installation Folder window, specify a path to the installation folder for the Avaya
Collaboration Services Configurator, and click Next.

6. In the Confirm Installation window, click Next to start the installation.

The system displays the message: Please use Windows Update to check for any critical
updates to the .NET Framework.

7. In the Installation Complete window, click Close to exit the setup wizard.

The Avaya Collaboration Services Configurator icon appears on your desktop.

Related Links
Building the installation packages on page 14

Configuring the installation packages for Collaboration
Services with Lync Integration

Before you begin
• Install the Avaya Collaboration Services Configurator.
• Know your service port number. The default port number is 40101.

Tip:
You may need to change the default port number in one of the following cases:
- You are running Collaboration Services on a shared server, such as a Citrix or VMware

environment
- Another application running in your environment uses the same port number

• Know any custom rule requirements:

- Browser subnet matching rule
- Browser URL matching rule
- Smart Tag matching rule for Microsoft desktop applications
- Conference dialer rules for click-to-join conference

Configuring the installation packages for Collaboration Services with Lync Integration
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Procedure
1. Double-click the Avaya Collaboration Services Configurator icon to open the Configurator

tool.

2. Read the information in the Welcome screen, and then click Next.

3. In the Collaboration Service Configuration screen, update the service port number if
necessary and select whether you want to build the Lync Add-in.

• If you are building the Lync Add-in, go to the next step.

• If you are not building the Lync Add-in, go to step 7 on page 16 on page 19.

4. In the Microsoft Lync Settings screen, click Change.

5. In the Lync Integration Settings window, select the settings you want to use. Then click
OK.

6. In the Configurator wizard's Microsoft Lync Settings screen, click Next.

7. In the Office and Browser Add-in Custom Rules screen, choose whether you want to use
custom rules. If you would like to use custom rules, select Yes, I would like to enter or load
some custom rules, and then go to the next step. If you are not using custom rules, select
No, I do not want to use custom rules, and then proceed with building the installation
packages.

• If you are using custom rules, go to the next step.

• If you are not using custom rules, go to the last step to build the installation packages.

8. In the Custom Rules Entry screen, under Office/Browser Add-in Custom Rules, do one
of the following:

• Click the Custom Rule Creator icon to open the Custom Rule Creator and create custom
rules as required to be included in the Collaboration Services installation package.

Refer to the Configurator user guide or online help for more information on creating
Browser Add-in custom rules.

• Click the folder icon to open and import an existing custom rule file.

9. When you are ready to build the installation packages for the Collaboration applications, go
to Building the installation packages on page 16.

Related Links
Building the installation packages on page 14

Building the installation packages
Before you begin

• Configure the installation packages for the Collaboration Services applications.

Building the installation packages
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Procedure
1. In the Configurator wizard's Build screen, click Change to browse for a destination folder.

2. Click Build.

The system displays the Build screen that shows the status of the build.

If the build is successful, the Avaya Collaboration Services folder opens and displays the
folders for the selected builds.

Result
If you are deploying with Lync Integration, a successful build includes the following folders:

• Collaboration Services
• Lync Add-in 2010 and 2013

If you are not deploying with Lync Integration, a successful build includes the following folders:
• Collaboration Services

Related Links
Building the installation packages on page 14

Distributing the installation packages
Following the successful build of the Collaboration application installation packages, distribute the
folder or folders that contain the appropriate installation packages to end users.

For more information on the installation packages, see Configurator on page 9.

For information on how to deploy the Collaboration applications on the desktop, see Deploying the
applications on the desktop on page 18.

Related Links
Building the installation packages on page 14

Distributing the installation packages

June 2014 Administering Avaya Collaboration Services      17
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering Avaya Collaboration Services


Chapter 6: Deploying the applications on
the desktop

The following sections describe installation and configuration for Avaya Collaboration Services.

Related Links
Installation and configuration parameters on page 18

The following table describes the main installation and configuration parameters for Collaboration
Services.
Installing the Avaya Collaboration Services applications on page 19
Installing Collaboration Services on multiple machines from a remote server on page 24
Installing and uninstalling Collaboration Services on a shared server on page 24
Configuring instant messaging and presence functionality on page 25

Installation and configuration parameters
The following table describes the main installation and configuration parameters for Collaboration
Services.

Parameter Description
-uninstall Enter this parameter in the Command window to uninstall Collaboration

Services. The complete command line should be
Avaya.CollaborationServices.Installer.exe —uninstall.

-silent Enter this parameter in the Command window to start a silent installation.
With this parameter, you can complete the installation with applications
such as Internet Explorer running in the background. Collaboration
Services appears the next time you restart the application.

The complete command line should be
Avaya.CollaborationServices.Installer.exe —silent. When
you add -uninstall to the command line, you start a silent uninstallation.

-silentshowopenappsdlg Enter this parameter in the Command window to start a silent installation.
With this parameter, you receive a warning to close applications such as
Internet Explorer during the installation. The complete command line
should be Avaya.CollaborationServices.Installer.exe —
silenthowopenappsdlg.
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Parameter Description
-ISICITRIX Enter this parameter in the Command window to install Collaboration

Services in a Citrix environment. For more information, see Installing and
uninstalling Collaboration Services on a shared server on page 24.

-disableIMIntegration or
EnableCustomIMProviders

Use this parameter to enable or disable Collaboration Services IM
integration with the Outlook contact card. You can access this parameter
from the Windows Registry under HKEY_CURRENT_USER > Software >
Wow6432Node > Avaya > Collaboration.

Setting EnableCustomIMProviders to true enables Collaboration Services
IM integration with the Outlook contact card. Setting
EnableCustomIMProviders to false disables Collaboration Services IM
integration with the Outlook contact card.

Installing the Avaya Collaboration Services applications
Before you begin

• Have the Avaya.CollaborationServices.installer.exe file.
• Make sure your system meets the requirements for end users.

Table 5: Office Add-in requirements for end users

Software
prerequisites

Supported OS Supported Office
versions

Installation privileges

Users must have the
following software
installed on their
systems before running
the Collaboration
Services Office Add-in.

- Microsoft.NET
Framework 3.5 and
4.0

- Avaya Microsoft Lync
Integration and
Microsoft.NET
Framework 4.0 if
integrating with
Microsoft Lync
Integration

Users must be running
one of the following
operating systems (OS):

- Microsoft Windows 7

- Microsoft Windows 8

Make sure the OS is fully
updated with all Microsoft
patches.

Users must be
using one of the
following Microsoft
Office versions:

- Office 2007

- Office 2010

- Office 2013

Administrator

Installing the Avaya Collaboration Services applications
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Table 6: Browser Add-in requirements for end users

Software prerequisites Supported OS Supported browsers Installation
privileges

Users must have the
following software installed
on their systems to use the
Collaboration Services
Browser Add-in.

- Microsoft.NET Framework
3.5 and 4.0

- Avaya Microsoft Lync
Integration and
Microsoft.NET Framework
4.0 if integrating with
Microsoft Lync Integration

Users must be running
one of the following
operating systems (OS):

- Microsoft Windows 7

- Microsoft Windows 8

Make sure the OS is fully
updated with all Microsoft
patches.

Users must be using
one of the following
browsers:

- Internet Explorer 8, 9,
10, and 11

- Firefox

- Google Chrome

Administrator

Procedure
1. Close all existing Microsoft Outlook and web browser sessions.

2. Open the Avaya Collaboration Services folder and navigate to the
Avaya.CollaborationServices.installer.exe file.

3. Double-click on the exe file and follow the instructions to complete the installation.

You can use the Avaya.CollaborationServices.Installer.exe -silent
command line to perform a silent installation.

4. Launch Microsoft Outlook.

5. In the Microsoft Office Customization Installer window, click Install to complete the
installation.

If you click Don't Install, use the following steps to enable the Office Add-in.

a. Navigate to Add-ins

• In Outlook 2007, from the Tools menu, click Trust Center and then Add-ins.
• In Outlook 2010 and 2013, from the File menu, click Options and then Add-ins.

b. Select COM Add-ins from the Manage drop-down menu and click Go.
c. In the COM Add-ins window, select Avaya and click OK.

Note:

If the Office Add-in is deployed with Lync Integration, disable the Telephone (XML)
feature in Microsoft Outlook. If you do not disable this feature, you will receive a
redundant Telephone Number menu option when using the Click-to-Call feature.

6. Launch your web browser.

If the Browser Add-in toolbar is not visible, right-click on the IE toolbar and select Avaya
from the list.

Deploying the applications on the desktop
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If you are a user of IE 9 or higher, at the prompt, enable the Browser Add-in and then restart
IE.

Note:

If you are using IE 10 or 11 with Windows 8.1, you must disable Enhanced Protected
Mode (EPM) for Avaya Collaboration Services to work.

Next steps
Enable the Avaya (Avaya) and Person Name Smart Tags in your Microsoft Office applications.

Note:
The Person Name option is not available in Excel and Power Point.

Related Links
Deploying the applications on the desktop on page 18
Enabling Smart Tags in Outlook in the Office 2007 suite on page 21
Enabling Smart Tags in Microsoft Word, Excel, or Power Point in the Office 2007 suite on page 22
Enabling Smart Tags in Outlook in the Office 2010 and 2013 suites on page 22
Enabling Smart Tags in Microsoft Word, Excel, or Power Point in the Office 2010 and 2013 suites on
page 23
Smart Tag limitations in Microsoft Office applications on page 23

Enabling Smart Tags in Outlook in the Office 2007 suite
Procedure

1. Open an instance of Microsoft Outlook.

2. From the File menu, select New, and then Mail Message.

3. Click the Microsoft Office button .

4. Click the Editor Options button.

5. On the left-hand-side pane, click Proofing.

6. Click the AutoCorrect Options button.

7. Click the Smart Tags tab.

8. Select Label text with smart tags.

9. In the Recognizers list, make sure Avaya (Avaya) and Person Name are selected.

10. Click OK.

11. On the left-hand-side pane, click Advanced.

12. In the Display email content section, select Show smart tags.

13. Click OK.

Installing the Avaya Collaboration Services applications
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Related Links
Installing the Avaya Collaboration Services applications on page 19

Enabling Smart Tags in Microsoft Word, Excel, or Power Point in
the Office 2007 suite

Procedure
1. Open an instance of the application (Word, Excel, or Power Point).

2. Click the Microsoft Office button .

3. Click the <application name> Options button, where <application name> can be Word,
Excel, or Power Point depending on the application.

4. On the left-hand-side pane, click Add-Ins.

5. From the Manage drop-down menu, select Smart Tags and click Go.

6. In the Auto Correct window, select Label text with smart tags.

7. For Microsoft Word, in the Recognizers list, make sure Avaya (Avaya) and Person Name
are selected. For Microsoft Excel and Power Point, in the Recognizers list, make sure
Avaya (Avaya) is selected.

Note:

The Person Name option is not available in Excel and Power Point.

8. Click OK.

Related Links
Installing the Avaya Collaboration Services applications on page 19

Enabling Smart Tags in Outlook in the Office 2010 and 2013 suites
Procedure

1. Open an instance of Microsoft Outlook.

2. Click the New E-mail button.

3. From the File menu, select Options.

4. From the Mail tab, click the Editor Options button.

5. On the left-hand-side pane, click the Proofing tab.

6. Click the AutoCorrect Options button.

7. Click the Actions tab.

8. Select Enable additional actions in the right-click menu.

Deploying the applications on the desktop
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9. Make sure that Avaya (Avaya) and Person Name are selected.

10. Click OK.

Related Links
Installing the Avaya Collaboration Services applications on page 19

Enabling Smart Tags in Microsoft Word, Excel, or Power Point in
the Office 2010 and 2013 suites

Procedure
1. Open an instance of the application (Word, Excel, or Power Point).

2. Open the <application name> Options window by clicking the Options button under the
File tab, where <application name> can be Word, Excel, or Power Point depending on the
application.

3. On the left-hand-side pane, click Proofing.

4. Click the AutoCorrect Options button.

5. Click the Actions tab.

6. Select Enable additional actions in the right-click menu.

7. In Microsoft Word, make sure that Avaya (Avaya) and Person Name are selected. In
Microsoft Excel and Power Point, make sure that Avaya (Avaya) is selected.

Note:

The Person Name option is not available in Excel and Power Point.

8. Click OK.

Related Links
Installing the Avaya Collaboration Services applications on page 19

Smart Tag limitations in Microsoft Office applications
The following sections describe Smart Tag limitations that affect Avaya Collaboration Services
functionality in Microsoft Office applications.

Valid telephone numbers are not recognized in Microsoft PowerPoint
PowerPoint can pass numbers to the Smart Tag recognizer incorrectly. Even if the number is in the
correct E.164 format, Collaboration Services might not be able to read the phone number properly.
For example, if the number entered in PowerPoint is +8482010541, PowerPoint might send the
number to the Smart Tag recognizer as 8482010541 or might append another country code (such
as +1) to the beginning of the number. Due to the absence of the +, Collaboration Services cannot
recognize the phone number. Therefore, when you right click the phone number and select
Additional Actions, Collaboration Services does not provide a Call <number> option.

Installing the Avaya Collaboration Services applications
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To work around this issue, you can select the entire phone number with your mouse cursor. This
triggers Collaboration Services to recognize the phone number and provide the Call <number>
option under Additional Actions.

Installing Collaboration Services on multiple machines
from a remote server

To facilitate the headless install of the Office and Browser Collaboration Services applications using
a software distribution system, an installer.exe is available in the application directory.

Before you begin
• Meet the end-user requirements as described in System requirements on page 11.

Procedure
1. Include all of the output files other than the registry files (.reg) from the build for a given

application.

2. Zip these files to be used in a software distribution system (such as Microsoft SMS).

3. After the contents of the directory are placed on a user’s system, run the following command:
Avaya.CollaborationServices.installer.exe —silent.

Next steps
Enable the Avaya (Avaya) and Person Name Smart Tags in your Microsoft Office applications.

Note:
The Person Name option is not available in Excel and Power Point.

Related Links
Deploying the applications on the desktop on page 18

Installing and uninstalling Collaboration Services on a
shared server

Before you begin
• You must have administrative privileges on the local desktop.
• Have the Avaya.CollaborationServices.installer.exe file.

About this task
Use this procedure to install or uninstall Avaya Collaboration Services in a Citrix environment.

Deploying the applications on the desktop
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Procedure
1. Close all existing Microsoft Outlook and web browser sessions.

2. Open Windows Explorer and navigate to the location of the Collaboration Services
installation file.

3. Open a Command window.

4. In the Command window, change to the directory containing the Collaboration Services
installation file.

5. For installing, enter the following command line in the Command window:
Avaya.CollaborationServices.Installer.exe -install -ISCITRIX=true

6. For uninstalling, enter the following command line in the Command window: .
Avaya.CollaborationServices.Installer.exe -uninstall -ISCITRIX=true

7. Follow the instructions to complete the installation.

Restart your machine if prompted.

Configuring instant messaging and presence functionality
Before you begin
Set required installation and configuration parameters.

About this task
Use the following procedure to enable UC desktop clients to access Instant Messaging and
Presence from Collaboration Services.

Procedure
1. Make sure the default instant messaging application is set to Collaboration Services.

2. Navigate to HKEY_CURRENT_USER > Software > Avaya > Collaboration >
DirectoryData.

3. Set imHandleAttributeName to a value that your UC client recognizes.

The Collaboration Services Active Directory server can access this value to provide IM and
Presence functionality to the UC client. This value indicates the type of user information,
such as the email address or phone number, that Collaboration Services uses to provide IM
and Presence. The following are examples of values that you can set for
imHandleAttributeName.

•  msRTCSIP-PrimaryUserAddress

• mail

• telephonenumber

Configuring instant messaging and presence functionality
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Chapter 7: Uninstalling the Configurator or
the Collaboration applications

Procedure
1. From the Windows Start menu, select Settings > Control Panel > Uninstall or change a

program.

2. In the Add or Remove Programs window, select one of the following options and then click
Uninstall.

• Select Avaya Client Applications Configurator to remove the Configurator

• Select Avaya Collaboration Services to remove the Office and Browser applications

3. At the prompt to uninstall, click Yes.

Note:

After uninstalling, the following files are not automatically deleted from AppData >
LocalLow > Avaya > Collaboration. You can delete these files manually.

• DCE.BrowserAddin.InstallState

• Avaya.Collaboration.ApplicationConfiguration.InstallState

• OfficeAddIn.InstallState
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Chapter 8: Upgrading the Configurator and
Collaboration Services

About this task
Use this procedure to upgrade theAvaya Collaboration Services Configurator and Collaboration
Services.

Note:
When you upgrade to a new version of Microsoft Office (for example, if you upgrade from Office
2010 to Office 2013), you must also upgrade to a new version of Collaboration Services to
support the new version of Microsoft Office.

Procedure
1. Close any instance of a Collaboration application or of an application running a Collaboration

application.

2. If you are upgrading within the same release, uninstall the old versions of the Configurator
and the Collaboration applications.

3. Install the new Configurator; see Installing the Configurator on page 14.

4. Build the installation packages for the Collaboration applications; see Building the installation
packages on page 14.

5. Install the Collaboration applications; see Deploying the applications on the desktop on
page 18.

Result
The new versions of the Configurator and Collaboration Services are ready to use. However, after
upgrading to a new release, the following files from the previous release (located under AppData >
LocalLow > Avaya > Collaboration) are not automatically deleted. You can delete these files
manually.

• DCE.BrowserAddin.InstallState
• Avaya.Collaboration.ApplicationConfiguration.InstallState
• OfficeAddIn.InstallState
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Chapter 9: Troubleshooting the
Configurator and the
Collaboration Services
applications

Use the information in this chapter to troubleshoot issues with the Avaya Collaboration Services
Configurator and the Collaboration Services applications.

Activating Avaya Collaboration Services in the Microsoft
Office suite

About this task
The Avaya Collaboration Services add-in must be a trusted publisher in the Microsoft Office suite in
order for users to use features such as click-to-call from a Microsoft Office application. Use the
following procedure to resolve this issue. You must only implement this change once and
Collaboration Services will be available in all Microsoft Office applications.

Procedure
1. Open a Microsoft Office document, such as a Word or Excel document.

2. Click the text in the Security Warning.

3. Under the Information window, in the Security Warning section, select Enable Content >
Advanced Options

4. In the Microsoft Office Security Options window, select Enable all code published by this
publisher.

5. Click OK to apply the change.

Collaboration Services should now be available within the Microsoft Office suite.
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Activating Avaya Collaboration Services in Internet
Explorer

About this task
You might need to update some settings in Internet Explorer (IE) for Collaboration Services to work.
For security reasons, some enterprises disable third-party extensions in IE, and this setting must be
enabled for the Collaboration Services add-in to appear in IE. On some Windows 8 machines,
Enable Enhanced Protected Mode might be turned on by default, and you need to disable this
setting for phone numbers to be properly highlighted in IE with Collaboration Services.

Procedure
1. Open the IE browser.

2. Click Tools > Internet Options.

3. Select the Advanced tab.

4. Under Browsing, select the Enable third-party browser extensions check box.

5. On Windows 8 machines, make sure the Enable Enhanced Protected Mode check box is
not selected.

6. Click Apply then OK to apply these changes.

Next time you open the IE browser, Collaboration Services should be visible and functioning
correctly.

Conference bridge details are not saved in Outlook
meeting invitations

Using Collaboration Services , you can add your conference details to a meeting invitation in
Outlook. If you close the meeting invitation without saving the meeting details, Outlook still saves the
details automatically. When you open the meeting invitation, Outlook displays the Host Conference
and Remove Conference Details buttons. Since you did not save the changes to the meeting
invitation, Outlook should display the Join Conference and Add Conference Details buttons.

Recovery action
No workaround is available. This issue occurs when you exit the meeting invitation without saving
the meeting invitation details.

Activating Avaya Collaboration Services in Internet Explorer
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Conference bridge numbers are marked as normal
telephone numbers

When Google Chrome or Internet Explorer (IE) are used to edit a page, email message, or
document, Avaya Collaboration Services cannot distinguish between conference bridge numbers
and normal telephone numbers. Therefore, conference bridge numbers are marked as normal
telephone numbers.

Recovery action
No workaround is available. This issue only occurs when you are editing in the browser, not when
you are just reading in the browser.

Invitation text is not removed from meeting invitation
In Outlook 2007 on a 32 bit Windows 7 Operating System, when you click the button to remove
conference details from the meeting invitation, the details might not get deleted.

Recovery Action
You must delete invitation text from the meeting invitation manually.

Join Conference and Host conference menu options do
not appear in Outlook

In an Outlook meeting invitation, you do not see the Join Conference or Host Conference button
as expected.

Root cause
The conference bridge number and web conference details are not properly formatted in the
meeting invitation according to Collaboration Services standards. The primary conference bridge
phone number, participant pass code, and web conference link should be populated in the Location
field.

Recovery Action
1. Delete the meeting occurrence or series in your Outlook calendar.
2. If required, you can ask the meeting organizer to resend the meeting invitation with the

conference details properly formatted.

Troubleshooting the Configurator and the Collaboration Services applications
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Launching web collaboration in a Citrix XenApp
environment with Google Chrome

In a Citrix XenApp environment, when you launch web collaboration from Lync Integration, or from
an Outlook Meeting Invitation or Reminder window with Collaboration Services , and your default
web browser is Google Chrome, the web collaboration link does not open properly. The Google
Chrome browser opens but you are not automatically directed to the web collaboration as expected.

Recovery action
Before trying to launch web collaboration from Outlook or Lync Integration, make sure the Google
Chrome browser is open. If the browser is already open, web collaboration should launch
successfully as expected.

Log file uninstallation error
The following error message appears when uninstalling Collaboration Services through the
Windows Control Panel:
Error opening installation log file. Verify that the specified location 
exists and is writable.
Root Cause
This issue occurs when Windows Installer Logging is enabled, but the Windows Installer engine
cannot write the uninstallation log file correctly. For more information, see http://
support.microsoft.com/kb/2564571/en-us.

Recovery Action
Stop and restart the Explorer.exe process using Task Manager.

Modifying Avaya Collaboration Services presence and
instant messaging setting for Outlook

Before you begin
Make sure Outlook is not running.

About this task
Use the following procedure to enable or disable the default Collaboration Services Presence and
instant messaging (IM) integration into Outlook. This way, users can choose to use Outlook
Presence and IM functionality from the Lync 2010 or 2013 client instead of from Collaboration
Services.

Launching web collaboration in a Citrix XenApp environment with Google Chrome
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Procedure
1. Start the registry editor on your computer.

2. Navigate to HKEY_CURRENT_USER > Software > IM Providers

3. Modify the DefaultIMApp value as appropriate.

• To disable the Collaboration Services Presence and IM functionality and set it to Lync
2010, set the value to Communicator.

• To disable the Collaboration Services Presence and IM functionality and set it to Lync
2013, set the value to Lync.

• To enable the Collaboration Services Presence and IM functionality, set the value to
CollaborationService.

4. Restart Outlook.

Nationally formatted numbers are not highlighted when
Office 365 is running in Google Chrome

The default locale for Office 365 is the United States (US). If you override the locale to another
country when running Office 365 in Google Chrome, and then try to edit the Office 365 document,
national numbers for the new locale will not be highlighted. Instead, the default US numbers
continue to be highlighted. This occurs because the internal URL for Office 365 is automatically
redirected when a document is edited in Google Chrome.

Recovery action
There is no workaround for this issue in Google Chrome. Google Chrome will only highlight
nationally formatted numbers for a new locale if you do not switch to Edit mode. This issue does not
occur when you edit an Office 365 document in Internet Explorer (IE).

Numbers are not highlighted in the search results
When you search for an E.164 number in Internet Explorer, Mozilla Firefox, or Google Chrome,
Collaboration Services does not highlight some of the numbers in the search result.

Cause
Collaboration Services does not recognize numbers embedded within HTML tags.

Recovery Action
No workaround is available.

Troubleshooting the Configurator and the Collaboration Services applications
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Outlook freezes when using the click-to-call feature on an
email signature

When you click a telephone number on an Outlook signature to initiate a call with Avaya
Collaboration Services, Outlook freezes for approximately 3 minutes before the call is initiated. This
does not occur when you use click-to-call with a phone number in the body of the email.

Recovery action
The issue occurs when the Instant Messaging Contacts action is enabled in Outlook. To resolve this
issue, see Solution: Disabling the Instant Messaging Contacts action in Outlook on page 33.

Solution: Disabling the Instant Messaging Contacts action in
Outlook

About this task
Use this procedure to disable the Instant Messaging Contacts action in Outlook. When this action is
enabled, Outlook freezes when you use click-to-call functionality in an email signature.

Procedure
1. In Microsoft Outlook, select Options.

2. From the Mail tab, click the Editor Options button.

3. On the left-hand-side pane, click the Proofing tab.

4. Click the AutoCorrect Options button.

5. Click the Actions tab.

6. Deselect Instant Messaging Contacts.

Re-enabling Avaya Collaboration Services in Google
Chrome

About this task
After removing the Collaboration Services add-in from Google Chrome, the add-in cannot be re-
enabled even after the add-in is reinstalled. Do one of the following to work around this issue.

Important:
For Avaya one-X® Communicator Windows customers, when you upgrade to the latest version
of Avaya Collaboration Services. you may not be able to see the Avaya Collaboration Services
add-in in Google Chrome. To resolve this issue, see For Avaya one-X Communicator
customers: Enabling Avaya Collaboration Services in Google Chrome on page 34.

Outlook freezes when using the click-to-call feature on an email signature
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Procedure
• If you have already removed the Avaya Collaboration Services add-in from Google Chrome,

you must uninstall and reinstall the Google Chrome browser before you can re-enable the add-
in.

• If you have not yet removed the Avaya Collaboration Services add-in from Google Chrome but
are planning to do so, disable the add-in instead of removing it.

This way, you will be able re-enable the Avaya Collaboration Services add-in in Google
Chrome at any time.

For Avaya one-X® Communicator customers: Enabling Avaya
Collaboration Services in Google Chrome

About this task
This procedure applies to Avaya one-X® Communicator customers. Use this procedure if the latest
version of Avaya Collaboration Services does not work in Google Chrome.

Procedure
1. Export the registry key HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome

to another location on your machine.

2. Delete the original registry key from HKEY_LOCAL_MACHINE\SOFTWARE\Policies
\Google\Chrome.

3. Open Google Chrome and enter chrome://extensions in the address bar.

4. Drag the extension under C:\Program Files (x86)\Avaya\Client Applications
\Collaboration Services\accs.crx to the open Google Chrome Extensions page.

5. Delete the Avaya extension in Google Chrome.

Make sure you do not disable the extension instead of deleting it.

6. Exit Google Chrome.

7. Import the registry key you exported in step 1 on page 34.

8. Start Google Chrome.

When you install the latest version of Collaboration Services , the Collaboration Services
add-in should appear and work properly in Google Chrome.

Troubleshooting the Configurator and the Collaboration Services applications
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Setting the debug log levels for the Configurator and the
Collaboration applications

About this task
Use the following procedure to set the debug log level and gather debug log information for the
Avaya Collaboration Services Configurator and applications.

Procedure
1. Open the log4net.config file.

• For the Configurator, the file is located under AppData > LocalLow > Avaya >
Collaboration > Configurator > Logs.

• For the Office and Browser Collaboration applications, the file is located under AppData >
LocalLow > Avaya > Collaboration > Logs.

2. In the <level value="INFO" /> line, change INFO to DEBUG.

3. Save the file.

Note:

If you encounter an error when you try to save the file, run a file editor program, such as
Notepad, as an administrator.

4. Open the log files. They can be accessed from Start > Programs > Avaya.

Uninstalling Collaboration Services in Google Chrome
Before you begin
You must have administrative privileges on the local desktop.

About this task
You can not disable the Collaboration Services add-in in Chrome by changing the settings in the
Chrome extension page.

Procedure
1. Close all existing Google Chrome web browser sessions.

2. Open the Command window as an administrator.

3. Locate the Collaboration Services folder and enter the file path in the Command window.

4. For uninstalling the Collaboration Services in Chrome, run the following command in the
Command window:
UninstallChromeExtension.bat

5. Start Google Chrome.

Setting the debug log levels for the Configurator and the Collaboration applications
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Using Avaya Collaboration Services in a Google Chrome
proxy environment

About this task
When Google Chrome is running in a proxy environment, you must enable the bypass proxy option
for local addresses. If this is not done, Collaboration Services will not work properly in Google
Chrome.

Procedure
1. In the Google Chrome browser, navigate to Settings.

2. When the Settings screen appears, click Show advanced settings.

3. Under Network, click Change proxy settings.

4. Under the Connections tab, click LAN settings.

5. In the LAN Settings window, under Proxy server, select the Bypass proxy server for local
addresses check box.

Troubleshooting the Configurator and the Collaboration Services applications

36     Administering Avaya Collaboration Services June 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering Avaya Collaboration Services


Chapter 10: Configurator user guide

The Configurator user guide describes how to use the Configurator to build the installation packages
for the Collaboration applications.

This information is also available from the online help that is packaged with the Configurator. To
access the online help, do the following:

• When you complete the install, from the Start menu, select Programs > Avaya > Client
Applications > Configurator > Help

•
When you run the Configurator, click the Help icon ( )

Avaya Configurator
Use the Avaya Configurator to build the installation packages for:

• Avaya Office and Browser Collaboration Services applications
• Avaya Microsoft Lync Integration

The Configurator must be run on a Windows desktop. You cannot execute the Configurator from a
Microsoft Terminal Server.

Click Close to close the Configurator.

When you are ready to build the installation packages for the Collaboration applications, in the
Configurator wizard's Build screen, the Destination Folder section displays the name of the folder
where the final installation packages are built. Click Change to browse for a destination folder.

Click Build to start the build of the installation packages.

Collaboration Services configuration
Office and Browser Custom Rules
Custom rule files define:

• Browser subnet matching rule
• Browser URL matching rule
• Smart Tag matching rule for Microsoft desktop applications

June 2014 Administering Avaya Collaboration Services      37
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Administering Avaya Collaboration Services


• Conference dialer rules for click-to-join conference

In the Configurator wizard's Custom Rules Entry screen, under the Office and Browser Custom
Rules section, do the following:

Click the folder icon ( ) to open an existing Office Add-in or Browser custom rule (acr) file.

Click the Custom Rule Creator icon ( ) to open the Custom Rule Creator and create Office or
Browser custom rules.

Overview of telephone number detection with Office and Browser
Add-in rules

The standard regular expression rule in the Office and Browser Add-ins searches a selection of text
in a web page, email, or other type of file and validates potential numbers to make sure they are
telephone numbers. The following sections describe validation steps and the purpose of custom
rules. For more details about the regular expression syntax, see HTTP://
MSDN.MICROSOFT.COM/EN-US/LIBRARY/AZ24SCFC.ASPX.

Standard validation steps
The Office and Browser Add-ins perform the following main validation steps to determine if a
number is a telephone number:

• If the number is preceded by a country code, the internal database validates the country code.
If the country code in the number is valid, the database checks if the number matches the
corresponding dialing pattern for the country.

• If the number does not contain a country code, the database determines the locale context for
the number based on the locale of the web page, where the email was sent from, or where the
file was created. The database uses the locale context to determine the country code for the
number and then checks if the number matches the dialing pattern for the country.

• The database ensures that the number has at least one separation character to be considered
a telephone number. If the number does not have a country code preceded by a +, the number
must have a space, period, slash, dash, or brackets to be considered a telephone number.

The Office and Browser Add-ins normalize validated telephone numbers and present these
telephone numbers to the user in the E.164 format with the country code preceding number.

The following table shows examples of valid telephone numbers for two different locales and the
normalized results of these telephone numbers.

Table 7: Examples of normalized telephone numbers

Locale and country code Examples
Europe, with the country code +41 The original numbers on the page are:

• +41 (0)44 450 90 90

Configurator user guide
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Locale and country code Examples
• (0)44 450 90 90

The normalized result presented in the E.164 format will be
+41444509090.

North America, with the country
code +1

The original numbers on the page are:

• 257/222-4444

• 257-222-4444

• (257) 222 4444

The normalized result presented in the E.164 format will be
+12572224444.

Custom rules
Some organizations have internal dialing patterns or extensions that the standard pattern matching
and validation rules cannot recognize. You can use the Avaya Collaboration Services Configurator
to create custom rules that recognize these telephone numbers in web pages, documents, and
bodies of emails. There are three types of custom rules that you can create:

• SmartTag rule for the Office Add-in: this rule only recognizes numbers that appear in
SmartTags. For example, this rule can recognize numbers in an Outlook email body and in a
Microsoft Word or Excel document.

• URL rule for the Browser Add-in: use this rule if the organization has a common URL pattern
for intranet domains.

• Sub-net rule for the Browser Add-in: use this rule if the organization has a set of numbers
prefixing intranet domains.

For all three custom rules, you can define a range rule or a pattern matching rule. The following
table compares range and pattern rules and describes when to use each rule.

Table 8: Description of range and pattern rules

Range rule Pattern matching rule
Range rules include all numbers within a specific
range. With this type of rule, a number must have at
least one separation character to be considered a
telephone number. For example, if you define a
range rule of 2222222-5555555, the following
numbers would be marked as telephone numbers:

• 222-3333

• 222 3333

• 444-33-22

However, 2223333 and 4443322 would not be
marked as telephone numbers because these
numbers do not contain any separation characters.

Use a pattern matching rule to define a unique
pattern that the range rule does not cover. For
example, use a pattern matching rule if you need the
system to recognize a 6 digit number with no
separation characters as a telephone number.

The following are examples of pattern matching rules
that you can define to detect telephone numbers.

• For matching 6 digit numbers: \d{6}
• For matching 7 digit numbers: \d{7}
• For matching 4 digit extension numbers with the

extn prefix: (?:extn)(\d{4})

Collaboration Services configuration
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Custom Rule Creator
Use the Custom Rule Creator to create the Office and Browser Add-in Custom Rule files. These
files contain the custom number and pattern matching rules to be included in the corresponding add-
in installation package.

The toolbar on the Custom Rule Creator window consists of the following icons.

Icon Description
Creates a new empty custom rule file.

Opens an existing custom rule file. You can open a custom rule file by double-clicking on
the file or by drag-and-dropping the file into the Custom Rule Creator.

Saves the current custom rules file. The Save As dialog appears if the file has not been
previously saved.

Presents the Save As dialog allowing for a new file name to be associated with the
current file.

Imports an existing custom rule file. You can also drag-and-drop an existing custom rule
file into the Custom Rule Creator.

Office Custom Rule Creator
Right-click in the Custom Rule Creator window or on a selected rule item to see the following
options. You must select at least one item for some options to be available.

Item Description
New > Smart Tag Rule Opens the Smart Tag dialog to define a new Smart Tag custom rule.
New > Conference Dialer
Configuration

Opens the Conference Dialer Rule dialog to define the conference dialer
pattern matching rule for the click-to-join conference feature.

Edit Opens the selected custom rule item in the corresponding dialog to edit
the rule.

Delete Deletes the selected rule from the file.

Browser Custom Rule Creator
Right-click in the Custom Rule Creator window or on a selected rule item to see the following
options. You must select at least one item for some options to be available.

Item Description
New > Subnet Rule Opens the Subnet dialog to define a new custom rule for a particular

subnet.

Configurator user guide
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Item Description
New > URL Rule Opens the URL dialog to define a new custom rule for a particular URL

matching scheme.
Edit Opens the selected custom rule item in the corresponding dialog to edit

the rule.
Delete Deletes the selected rule from the file.

Smart Tag dialog
Use the Smart Tag dialog of the Creator to create number matching rules for the Smart Tag
component of the Office Add-in. The Office Add-in uses the number matching rule to determine if
text should be marked as a Smart Tag.

See Number Matching Rule on page 42 for more information on number matching rules.

Click Add to add the Smart Tag matching rule.

Click Cancel to ignore any changes.

Conference Dialer Rule
Use the Conference Dialer Rule dialog of the Custom Rule Creator to define a pattern matching rule
for the click-to-join conference feature of the Office Add-in. The Office Add-in uses the pattern
matching rule to normalize pass code and host code numbers before they are played into a
conference call. The Office Add-in also uses the conference dialer rule to detect pass codes in the
Location field of appointments.

Item Description
Passcode Normalization A rule to normalize the pass code before the application plays

the pass code into the conference call. A ‘p’ is equal to a 2–
second delay.

Hostcode Normalization A rule to normalize the host code before the application plays
the host code into the conference call.

Passcode Tokens The key word or words used to recognize the conference access
code in the Location field of an appointment.

Currently the Office Add-in uses the following key words when scanning for access codes: pc,
passcode, pswd, pw, pass, and pin. You cannot delete these key words; however, you can add
additional key words. Separate any additional key words with a semi-colon (;), for example,
password;the code;access code.

Click Add to add the conference dialer rule.

Click Cancel to ignore any changes.

Subnet dialog
Use the Subnet dialog of the Creator to create subnet-based number matching rules.

Item Description
IP Address The IP address used to define the base of the subnet. Right-click the

IP address to produce a context menu that allows for the resolution
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Item Description
of an IP address from a given machine name or URL. See 
Resolver on page 43 for more information on the Resolver.

Subnet Mask The mask that applies to the provided IP address to define the range
of IP addresses to which the rule applies.

Number Matching Rule The number matching rule that applies to the pages delivered from
the defined subnet. See Number Matching Rule on page 42 for
more information on number matching rules.

Click Add to add the number matching rule.

Click Cancel to ignore any changes.

URL dialog
Use the URL dialog of the Creator to create URL pattern-based number matching rules.

Item Description
URL Regular Expression The regular expression that applies to URLs from where pages are

being delivered. If the URL matches the defined pattern, the
following rule applies to the matching numbers.

Right-click on the text box to open a menu from which you can
launch the Expression Tester dialog, as well as the standard text
modification elements (cut, copy, paste, delete, and select all). See 
Expression Tester on page 43 for more information on the
Expression Tester dialog.

Number Matching Rule The number matching rule that applies to the pages delivered from
the URLs that conform to the above URL regular expression. See 
Number Matching Rule on page 42 for more information on
number matching rules.

Click Add to add the number matching rule.

Click Cancel to ignore any changes.

Number Matching Rule
Use the Number Matching Rule to define a range-based rule or a matching pattern-based rule.

Select the Range radio button to define a From and To limit in which a telephone number must fall
within to be considered a match. The number of digits in the Range From field must match the
number of digits in the Range To field. Define the range using numerical digits. The maximum
number of digits is 30 and maximum value is 999999999999999999999999999999 (30 nines).

If you need more specific matching, select the Matching Pattern radio button. You can then enter a
regular expression for the Number Matching Rule. Use the matching pattern option when you
require non-digit elements to determine a match.

Note:
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The operators ^ and $ are not permitted in the matching pattern as the rule is contained within a rule
that already takes these operations into account. This is also reflected when you test the matching
rule.

Right-click on the Number Matching Rule text box (in Matching Pattern mode) to open a menu from
which you can launch the Test Expression dialog, as well as the standard text modification elements
(cut, copy, paste, delete, and select all).

See Expression Tester on page 43 for more information on the Expression Tester dialog.

Expression Tester
The Expression Tester dialog of the Creator lets you test regular expressions. As you enter text into
the Source text box, the Results text box updates dynamically with any successful matches.

Resolver
The Resolver dialog of the Creator lets you resolve a URL or a machine name to the corresponding
IP address.

Enter the URL or host name to resolve and click Resolve. If the resolution is successful, the result is
placed in the IP address field of the Subnet dialog.

Click Cancel to close the Resolver.

Lync Integration
In the Configurator wizard's Collaboration Service Configuration screen, you can choose to
configure the build for Lync Integration.

For more information on Lync Integration, see the following document:
• Avaya Microsoft Lync Integration Fundamentals for Avaya Aura® (NN10850–014)

Microsoft Lync Settings
In the Microsoft Lync Settings screen, click the Change button to open the Lync Integration
Settings window.

Lync Integration Settings
Use the Lync Integration Settings window to configure the settings for the Lync Integration build.

The toolbar on the Lync Integration Settings window consists of the following icons.

Icon Description
Opens an existing settings file. Open the settings file by double-clicking on the file.

Lync Integration
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Icon Description
Saves the current settings file. The Save As dialog appears if the file has not been
previously saved.

Presents the Save As dialog allowing for a new file name to be associated with the
current file.

Resets the settings to the initial state.

Obtaining version information
To obtain version information for the Configurator, do the following:

1. In the Configurator, click Help.

2. In the Help window, click  to view the version information for the Configurator.

Accessing log files
Logs are generated with every build of the Configurator, and these logs contain the results of the
build. With each Configurator build, logs are appended to log files. A maximum of 10 log files can be
generated with each build and the maximum size of each log file is 3 MB.

Use the Configurator log files to troubleshoot issues. You can access Configurator log files under
AppData > LocalLow > Avaya > Collaboration > Configurator.

Configurator user guide
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Chapter 11: Collaboration Services

Avaya Collaboration Services combines the Office and Browser Add-in applications to
communication-enable Microsoft Office and web browsers. The Collaboration Services offer
features such as initiating voice and video calls, scheduling meetings with a contact, click to join or
host a conference, as well as instant messaging and presence.

Note:

The instant messaging and presence features might not be supported on some deployments.

Use the Collaboration Services icon on your task bar to:

• Access help information and documentation

• View and modify the Office and Browser application settings.

Settings panel
The following tabs are available in the Collaboration Services Settings panel. You can access the
Settings panel from the task bar on your desktop.

Preferences
Use this tab to select the interface language for Collaboration Services. You only need to do this if
the interface language you want to use is different from the default language of your operating
system.

Conference Configuration
Use this tab to access the Conference Bridge Wizard.

You can also access the Conference Bridge Wizard from the Start menu, under Programs >
Avaya > Client Applications > Collaboration Services
Support
Use this tab to enable diagnostics and report issues.

About
Use this tab to obtain release and version information for the Collaboration Service.
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Conference bridge configuration
Use the Avaya Conference Bridge Wizard to edit your conference bridge details. You can use these
conference bridge details to:

• Schedule a meeting with a contact from Microsoft Outlook

• Join or host a conference from a web browser, Microsoft Outlook, or Lync Integration (if
installed)

• If you are using Lync Integration, share conference bridge details with contacts in an instant
messaging (IM) conversation

After you install Collaboration Services, the Avaya Conference Bridge Wizard appears the first time
you launch Microsoft Outlook. To access the Avaya Conference Bridge Wizard in the future, do one
of the following:

• From the Start menu, select Programs > Avaya > Client Applications > Collaboration
Services > Conference Bridge Wizard.

• Select the Conference Configuration tab in the Collaboration applications Settings panel.

Configuring conference bridge details
Use the following procedure to add, modify, and delete your bridge and web conference details.

Before you begin
• Make sure the Avaya Conference Bridge Wizard is open.

Procedure
1. Read the information in the Welcome screen and then click Next.

2. In the Scanning for Conference Bridge Data screen, you can allow the wizard to scan your
Outlook calendar for conference bridge information that you entered when creating new
meeting requests.

a. To scan your Outlook calendar for conference bridge information, click Scan.

The scan option attempts to auto-detect your conference bridge details and populate
this information in the Conference Bridge Wizard. You must check the remaining
screens in the Wizard to make sure the details obtained from the scan are correct and
to fill in missing details that were not detected.

b. To skip the scan and go to the next screen in the wizard, click Next.

3. In the Conference Bridge Details screen, you can add, modify, and delete conference
bridges.

You can configure multiple bridges and multiple access numbers for each bridge.

Collaboration Services
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Tip:

If you are using the Collaboration feature in Lync Integration, use this screen to specify
which bridge access number is the default number. This way, if you double-click the
Collaboration icon from the Lync Integration bar without selecting a bridge access
number to call, Lync Integration will automatically call the appropriate default number.

a. To add a conference bridge, click Add. In the Conference Bridge Details window, enter
the following information:

• In the Description field, enter a name for your conference bridge. If applicable,
include the locale or country for the bridge in this field (for example, US bridge).

• In the Access Numbers field, click Add to enter a new access number for the
bridge.

The Conference Bridge Configuration tool recognizes local telephone numbers based
on your computer's locale. When you enter a local telephone number, accept the
prompt asking if you want to switch the telephone number to the E.164 format. A
warning message appears if the telephone number you entered appears to be invalid.

b. To modify a conference bridge name or access number, select the conference bridge
and then click Modify. In the Conference Bridge Details window, do the following:

• Edit the name of the conference bridge in the Description field

• Click Modify to update an existing access number for the conference bridge

• Click Delete to delete an existing access number for the conference bridge

c. To delete a conference bridge, select the bridge and then click Delete.

4. When you add a new bridge, in the Conference Bridge Details screen, enter the participant
and host passcodes.

• Under Participant Passcode, enter the conference bridge passcode for the participant.

• Under Moderator Passcode, enter the conference bridge passcode for the host.

5. Click Next to go to the next screen in the wizard.

6. In the Web Collaboration Details screen, enter your web conference details.

• Under Participant Web Collaboration URL, enter the web conference link for the
participant.

• Under Moderator Web Collaboration URL, enter the web conference link for the host.

To verify the web conference link for the participant or the host, click the Test button next to
the link that you want to verify.

7. Click Finish to exit the Conference Bridge Wizard.

Conference bridge configuration
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Office application features
The Collaboration Services Office application communication-enables the Microsoft Office 2007,
2010, and 2013 Suites. In Outlook or SharePoint, you can initiate a call by clicking on a contact’s
name or email address. Collaboration Services also provides a Smart Tag that recognizes person
names and telephone numbers within Word documents, Excel Spreadsheets, Power Point
presentations, and within the body of an e-mail displayed in Outlook.

Click-to-Call
Use click-to-call from the Office applications to quickly and simply initiate a voice or video call to a
selected contact number. The Office Add-in provides a Smart Tag, which when enabled, recognizes
person names and telephone numbers within Word documents, Excel Spreadsheets, Power Point
presentations, or within the body of an e-mail in Outlook.

Launching click-to-call from Microsoft Outlook
About this task
Launch click-to-call from Outlook in one of the following ways.

Procedure
• Within an Outlook item (Mail, Calendar, Contacts, Tasks), do the following to call a contact:

• In Outlook 2007, right-click on the contact’s e-mail address and select Additional Actions >
Call.

• In Outlook 2010 and 2013, right-click on the contact’s e-mail address, select Call Contact,
and then select the phone number to call.

• In Outlook 2010 and 2013, hover over the contact and click the phone number to call from
the contact card. This option is only available if an IM client, such as Microsoft Lync, is
installed.

• Hover over a contact to view the contact card. You can initiate a voice or video call from the
contact card.

• From an open contact, click the Call Contact button in the inspector ribbon to initiate a call to
the contact.

•
From a Reminder window, select a contact or mail reminder item and click the Call ( )
button to call the contact or sender of the mail. You can also initiate a video call.

Using click-to-call with Smart Tags
About this task
The click-to-call feature is available from any Office application that supports Smart Tags like Word,
Excel, Power Point, and Outlook. In Office 2007, when the Smart Tag recognizes a person's name
or telephone number, the system marks the name or number with a Smart Tag indicator or a purple
dotted underline. In Office 2010, text is not automatically recognized by a Smart Tag and does not
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display a purple dotted underline. Instead, you must trigger recognition by selecting the text and
clicking Additional Actions on the context menu.

Procedure
• To display the additional actions, move the insertion point over the text with a Smart Tag

indicator  until the Smart Tag Actions button appears.
• Click the Smart Tag Actions button to see the menu of actions.
• Click the appropriate menu item to access the click-to-call functionality.

• Select Call to make a call to the marked number. Note that the Smart Tag normalizes the
number to the E.164 format based on the locale of the current text. For example, if the locale
of your Office document is UK, a local UK number that appears on the document is marked,
normalized into the E.164 format, and then presented in the Call menu item.

• Select Remove this Smart Tag to remove only this Smart Tag instance.
• Select Stop Recognizing ”<number>” to stop recognizing a telephone number.

Outlook contact card features
From Outlook 2010 and 2013 contact cards, you can access the following features:

• Make a voice or video call to a contact
• View presence status
• Send an instant message (IM)

Important:

Some contact card functionality, such as IM and Presence or calling through an Outlook contact
card, might not be supported on certain deployments. If your deployment does not support
calling through an Outlook contact card, you must initiate a call by right-clicking on the contact
and selecting Additional Actions.

You can access the Outlook contact card features by clicking the appropriate icons on the Outlook
contact card. You can also expand the contact card to view the contact’s telephone numbers and
click the contact’s instant messaging address to initiate an IM session.

The instant messaging and presence feature is not available for Outlook 2007. In Outlook 2010 and
2013, the Collaboration Services must be deployed with Lync Integration to use Presence and IM
functionality.

Click-to-Join Conference
The click-to-join conference feature allows you to join or host a conference call from an Outlook
reminder or appointment item.

Related Links
Configuring conference bridge details on page 46

Office application features
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Use the following procedure to add, modify, and delete your bridge and web conference details.

Adding conference bridge details from an Outlook meeting request
About this task
When you create a new Outlook meeting request, you can add conference bridge details to the
Outlook meeting request.

Procedure
1. Click Add Conference Details at the top right-hand corner of the window.

2. Select a bridge from the drop down list.

If the bridge field is empty, you can find the default bridge number, Passcode, and Web
Conference link in the Location field. All other details, such as alternate bridge access
numbers, appear in the body of the meeting or appointment message. The body of the
message also includes conferencing links that you can use to quickly join the conference
from a web browser, mobile device, or tablet.

Removing conference bridge details from an Outlook meeting request
About this task
You can remove previously populated conference bridge details from a meeting request or
appointment.

Procedure
1. Open a meeting from your Outlook calendar.

2. Click Remove Conference Details at the top right-hand corner of the window.

Joining or hosting a conference from an Outlook reminder
Procedure

1. Select an appointment on the Reminder window.

2. If the appointment has bridge and web conference details, click the drop-down arrow beside
the click-to-join conference button and select one of the following options:

• Select the bridge to call.

• Click Launch Web Collaboration to enter the web conference.

• Click Call Access Number and Launch Web Collaboration to simultaneously dial into the
bridge on your phone and enter the web conference.

3. Click the Call button to click-to-call the contact or sender of the mail.

Joining or hosting a conference from an appointment inspector window
Procedure

1. Open an appointment from your Outlook calendar.
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2. If the calendar item has conference bridge details, select the available button on the
inspector ribbon:

• If you are not the appointment organizer, click Join Conference.

Note:

If the item has multiple conference bridge details, select the appropriate bridge access
number to call from the Join Conference button drop-down list.

.
• If you are the appointment organizer, click Host Conference.

Joining or hosting a conference from an appointment context menu
Procedure

1. From the Outlook calendar view, right-click a selected calendar item that contains
conference bridge details.

2. Select any of the following options from the context menu:

• If you are not the appointment organizer, click Join Conference to join a conference call.
• If you are the appointment organizer, click Host Conference to host the conference call.

If the calendar item has multiple conference call details, select the appropriate bridge access
number to call from the Join Conference drop-down list.

Joining conference and launching web collaboration from calendar invite
and meeting invitation

Procedure
1. Select a meeting invitation or open a meeting invitation from the Outlook calendar.

2. Right click a meeting, and select Host conference.

3. If the meeting has bridge and web conference details, click the drop down list and select any
of the following options:

• Call access number.
• Launch web collaboration.
• Call Access Number and Launch Web Collaboration.

If a meeting has more than one access number, Outlook selects and calls the primary
number in the list when you click Call Access Number and Launch Web Collaboration.

Limitations: Click to join conference
Outlook add-in issues
If other add-ins, such as the win-zip add-in, are enabled in Outlook, you might not be able to join or
host a conference by right-clicking on the meeting invitation. If you experience this issue, do one of
the following:

• Disable other add-ins in Outlook temporarily.

Office application features
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• Join the conference from the Reminder or Appointment Inspector window

Browser add-in issues
With Internet Explorer, Google Chrome, and Mozilla Firefox, Collaboration Services does not
support certain HTML tags for number marking or passcode detection. For example, Collaboration
Services does not detect conference numbers if the browser uses a <span> tag to separate the
conference bridge number and passcode.

Browser application features
The Collaboration Services Browser application extends the capability of the Internet Explorer (IE)
and Google Chrome browsers. For example, you can initiate a call directly from a web page that
contains valid telephone numbers (valid telephone numbers are numbers that have the format
appropriate to the locale of the web page). The Browser application automatically searches through
the page and marks the valid telephone numbers. When you hover your mouse over the marked
phone number, a button appears that you can click, to initiate a call from your preferred device. You
can also use the Browser application contact card to make voice and video calls, view a contact’s
presence status, and send an instant message to the contact.

Enabling the Browser application
Procedure

If you need to enable the Browser application in your web browser, do the following:

a. In IE, right-click the toolbar and select Avaya Collaboration Services.

b. In Firefox, navigate to the Add-on Manager and enable Avaya Collaboration
Services.

Note:

In Google Chrome, Collaboration Services is enabled automatically. You cannot disable
the Collaboration Services add-in within the Google Chrome browser. Your administrator
must disable and re-enable Collaboration Services on Google Chrome using a .bat file.

Browser application settings panel
You can access the Browser application settings panel from the toolbar near the top of your browser
window.

From the tabs at the top of the Browser application settings panel, you can access the following
features:
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Icons Feature
Select the appropriate country or locale. Use this option when you need to
override the automatically detected locale.

View and edit disabled sites. On these sites, the Browser application does not
detect telephone numbers

Access release and version information

Making a call
Use the Browser application to initiate a call from a telephone number listed on a web page. The
application automatically identifies and marks the numbers you can call.

Click the phone icon ( ) to place a call to the highlighted telephone number.

Browser application contact card
When you hover over the phone number of a contact in your browser, Collaboration Services
displays a contact card for the contact.

From this contact card, you can view the contact’s presence status and access the following icons:

Icons Feature
Initiate a voice call

Initiate a video call

Send an email

Schedule a meeting with the contact

Send an instant message (IM)

Click-to-conference
Use the Browser application to join or host a conference from a web browser. The Browser
application highlights conference bridge phone numbers on web pages or in the Outlook Web
Access tool. To dial in to a conference bridge, hover your mouse over the conference bridge phone

number and click the conferencing icon ( ) next to the number.

Browser application features
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Related Links
Configuring conference bridge details on page 46

Use the following procedure to add, modify, and delete your bridge and web conference details.
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Appendix A: Support matrix for Avaya
Collaboration Services

The following sections provide information about support for Avaya Collaboration Services
functionality within hosted applications, such as Google Applications and Office 365.

Note:

A hosted applications limitation exists where Collaboration Services cannot recognize phone
numbers embedded within image blocks. The following sections indicate where this limitation
applies.

Support for Google Applications
You can use Collaboration Services click to call and click to join or host a conference functionality
within Google Applications, such as Gmail, Calendar, Sheets, Documents, and Forms.

The following image provides an overview of Collaboration Services support with Google
Applications.

Note:
• You might need to disable Google Add-ins and Skype Click-to-Call to ensure proper

functioning of Collaboration Services browser add-in.
• In some cases, due to a Java script limitation, phone numbers and conference bridge

numbers are not highlighted in Calendar Reminder windows. This limitation applies in both
Read and Edit Mode. This limitation occurs intermittently and is not marked in the following
image.
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Figure 1: Google Applications support matrix

Support for Office 365
You can use Collaboration Services click to call and click to join or host a conference functionality
from Office 365 with the web versions of Microsoft Word, Excel, Outlook, Calendar, SharePoint, and
One Note.

The following image provides an overview of Collaboration Services support with Office 365 web
applications.

Note:
A hosted applications limitation exists where Collaboration Services cannot recognize phone
numbers embedded within image blocks.
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Figure 2: Office 365 support matrix

Support for Office 365
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